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Abstract: Microsoft Print Migrator 3.0 is the latest release of this utility which automates the backup and restore of print configuration data on print servers running Windows NT 4, Window 2000 and Windows .NET Server.  Version 3.0 introduces full support for Print Servers running Microsoft Cluster Services; Migration support from different version of Windows (e.g. Windows NT 4 to Windows 2000 Server); and Conversion of LPR ports to the Standard TCP/IP Port Monitor on Windows 2000, Windows XP and Windows .NET Server.  This paper is designed for systems integrators, administrators and architects who are planning, deploying or managing Windows Print Servers.
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About this document

This document describes the features and operation of the Print Migrator 3.0 from Microsoft.  Advisory notices that contain important information are marked with the [image: image1.png]


 icon.  Notes that are information or provide additional detail about a particular topic are marked with the [image: image2.png]C.
\



 icon.

For updates to this document or to the Microsoft Print Migrator 3.0 tool, please visit the print server home page at: http://www.microsoft.com/printserver.

For questions or problems with Microsoft Print Migrator 3.0, please contact: pmbeta@microsoft.com.
Overview

Microsoft Print Migrator 3.0 introduces three exciting new features not previously available in earlier versions.

Cross-OS Support – Allowing printer configuration from one version of Windows Server to another Windows Server.

Microsoft Cluster Services Support – Allowing printer configuration to be moved to or from print servers running Microsoft Cluster Services.

LPR Port Conversion – Automatically converts all LPR ports to the new Standard TCP/IP Port Monitor.

Microsoft Print Migrator 3.0 performs a complete printer configuration backup of a machine running:
· Windows NT 4.0, SP6a
· Windows 2000, SP2
· Windows XP

· Windows .Net Server

The configuration data is stored in a user specified CAB file.  The following data is backed up to the CAB file:
· Printers
· Printer PortTID_MONITORS
· Print DriversTID_DRIVERS
· Print Shares and File Shares
In addition to the cab file, Print Migrator logs status information to the file pm.log, located in %systemroot%\system32\spool\pm
Printers
Local printers created on the target server that accept jobs from clients and despool to a physical print device.  (Typically these printers despool over the network using a protocol such as TCP/IP.) 
Printer Port Monitors
Print Migrator recognizes and backs up the ports that are using one of the following printer port monitors:

· Standard Port Monitor 
· LPR Port Monitor
· Apple Talk Port Monitor

· Hewlett-Packard Network Port Monitor
· Lexmark MarkVision Port Monitor (IP/DLC)

· Digital Network Port Monitor
· Hewlett-Packard Jet Admin Port Monitor
· Local Port Monitor
Print Migrator does not back up the actual monitor, only the port attributes.  Prior to the restore operation, you must reinstall the original set of port monitors to ensure complete functionality.  Print Migrator will display a warning dialog for each monitor that is not present upon restore.
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  Note: If the /i command line switch is specified or the suppress warning popups checkbox is selected, this information is written to the log file only.
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  Note:  Print Migrator 3.0 does not backup or restore custom forms that may be in use.  These should be recreated on the target server after the printer migration is completed.
It is important to note that several port monitor types have been removed during the development of Windows 2000 and Windows .NET Server.  The table below lists the network ports that have changed in the Windows NT Server-based products.
Table 1 - Supported Printer Port Monitors

	
	Standard TCP/IP Port Monitor (SPM)
	LPR Port Monitor
	AppleTalk Port Monitor
	Hewlett-Packard Network Port
	Lexmark MarkVision Port
	Digital Network Port

	Windows NT 4
	NO
	Yes
	Yes
	Yes
	Yes
	Yes

	Windows 2000
	Yes
	Yes
	Yes
	Yes
	No*
	No*

	Windows .NET Server
	Yes
	Yes
	Yes
	No
	No
	No
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 * Note: These ports may be present on a Windows 2000 system that was upgraded from Windows NT 4.0.
Print Drivers

Printer drivers are installed to provide rendering information that the operating system and applications use when creating the actual data file that is sent to the physical print device.  There are two ways that printer drivers can be used on a Windows NT-based server:

Primary Driver – this driver is used by the server when NT-based clients are printing and are able to send Enhanced Meta File (EMF) jobs to the server.  This allows the Print Server to perform the rendering functions and frees the client application to return to normal operation more quickly.

Additional Driver – this driver (or set of drivers) is installed on the Windows NT-based Server, but is not actually executed by the Server.  Instead, the driver is ‘vended’ to down-level clients such as Windows 98 or to cross-platform clients like a Windows NT 4 computer running on an Alpha processor and printing to an x86-based Windows Server.

Windows NT 4.0 Server and Windows 2000, Windows XP and Windows .NET Server allow this Primary driver to be linked to the Additional Drivers, creating a Point-and-Print driver stack.  This enables clients running multiple versions of the Windows operating system to simply double-click a shared printer and have the driver installed automatically from the server.  More information about Windows Print Drivers and Point-and-Print can be found at the Windows Print Server web site.  (http://www.microsoft.com/printserver)
Print Shares and File Shares
All File shares, Print shares, and User permissions are backed up when performing a backup operation with Print Migrator 3.0.  By default, however, only Print shares and permissions are restored.  To include the File shares in the restore operation, check the Restore file shares option on the Printer Configuration Restore dialog window.
Merging and Overwriting Printer Configurations

Print Migrator 3.0 will add the new printer data to the existing data on the target server by default.  This allows print server consolidation to be done easily and in an automated fashion.  If, however, the goal is to restore a print backup to a server and have only those printers present, simply check the Replace (overwrite) existing printer queues checkbox in the Printer Configuration Restore dialog.
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Figure 1- Printer Configuration Restore Dialog
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  Note: When restoring printers that are using Windows NT 4 print drivers (Kernel Mode, Version 2 drivers) to a Windows 2000, Windows XP or Windows .NET Server, the Replace (overwrite) existing printer queues selection is not functional.  The checkbox will appear active, but it does not affect the restore function.  Due to changes in the location that printer information was stored in the registry, and overwrite would cause other problems with the print subsystem.  In this situation, the printers that are present on the target system will have to be deleted manually in the Printers folder, before performing the restore.
More information may be available in the Microsoft Knowledge Base found at Microsoft’s product support web site.
Full Command Line Operation

Print Migrator 3.0 can be completely run from command line, allowing scriptable operations.

To see a list of the available switches in Print Migrator 3.0, type printmig /? from a command prompt:
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Microsoft (R) Windows (TM) Printer Migrator 3.0
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usage: PRINTMIG [options] [server]
[-?] Display this message
[-b] Backup - followed by CAB file name
[-r] Restore - followed by CAB file name
[-0] Overurite existing print configuration
[-s] Restore file shares
[-1] Attempt to conuert LPR Ports to SPH
[-i] Suppress warning popups. Info still uritten to log file

If server is not specified then the local machine is implied.

Example command line to restore an existing config to a server
printmig -r d:\print\ps1.cab \\prt-srur

Example command line to backup a server to the specified file
printmig -b "\\filesru\store\print server 2.cab” \\prt-srur2





Figure 2 - Command Line Options for Print Migrator 3.0
If Print Migrator 3.0 is run from command line with any argument other than the target machine name - the graphical user interface (GUI) does pop up, but automatically shuts down when the operation is complete, in order to facilitate scripting.
Explanations of each of the command line switches follow:
  /?
HELP – Command list
  /b
BACKUP
  /r
RESTORE
  /o
OVERWRITE
  /s
FILE_SHARES
  /l
LPR2SPM

  /I
WARNING_SUPPRESS
/?

The /? option displays the command line options to a console.

/b Backup

The /b option causes Print Migrator 3.0 to backup the printer configuration of an NT 4.0, Windows 2000, Windows XP, or Windows .Net machine.

If a target machine name (in the form of \\machinename) is not specified then the local machine is implied. 

/r Restore

The /r option causes Print Migrator 3.0 to restore the specified printer configuration of an NT 4.0, Windows 2000, Windows XP, or Windows .Net Server to an NT 4.0, Windows 2000, Windows XP, or Windows .Net Server machine.  Like earlier versions of Print Migrator, version 3.0 only allows like platform restores i.e. x86 to x86.

The default behavior for /r is to merge the printer configuration from the CAB file to the existing printer configuration on the target.

/o Overwrite

The /o option in combination with the /r <CAB file name> option, causes the target server to be overwritten with the printer configuration contained in the CAB file.

/s Restore File Shares

The /s option merges the file shares in the CAB file with the existing file shares on the target.

/l LPR to SPM Conversion

The /l option will convert the LPR port to a Standard TCP/IP Port Monitor if the device is present on the network.  If the device is not found, an error message will be logged and the LPR port will be migrated.  LPR port monitor must be installed on the target server in order for the port(s) to function.
Microsoft recommends converting to the Standard TCP/IP Port Monitor for performance and scalability improvements.  See the references section for more information.
/i Suppress Warning Dialogs
The /i option disables warning dialogs that require user intervention (OK, Cancel, etc.).  Note that the warnings are still written to the log file.

It is recommended that this option be used when scripting Microsoft Print Migrator 3.0.

Using Print Migrator 3.0

Terminal Server Support
Although earlier versions of Print Migrator did not support restore operations to Terminal Server systems, v3.0 provides seamless restores.  This functionality is supported by a better logic routine when determining system variables and user variables.
Scheduling

Using the command line interface, Print Migrator 3.0 operations can be scripted and scheduled to occur at a selected time or period without requiring a logged on session.
Multi Threaded GUI

Print Migrator 3.0 was designed as a multithreaded Win32 application.  As such, operations that stall or are proceeding slowly in the background will not affect the user interface negatively.  
Log File

The log file records detailed information regarding backups, restores, and errors encountered.  The log filed is stored in %systemroot%\system32\spool\pm\pm.log.  If warning dialogs are suppressed, the log file still records warnings and errors.

In the Options menu, Log To Text is enabled by default.  De-select this option to disable logging to text file.  Note that all information will continue to be output to the Print Migrator 3.0 logging window (lower pane).

View

The Target… and Restore Local commands enumerate print queue information in tree view format.  The title bar identifies the computer that corresponds to the tree view displayed.  This computer is the target of all subsequent operations.

To enumerate a remote computer and populate the tree view

1. In the View menu, select Target…

2. In the Target Server box, type the name of the target server, for example \\server1. 

To enumerate the local computer and populate the tree view

3. In the View menu, select Restore Local.
Note: Any change to the print subsystem will not be reflected automatically in the current view.  To refresh the current view, select View and then Target for a remote server view, or View and then Restore Local for the local print subsystem view.
Backup

When backing up the printer configuration from a target server, Print Migrator presents the Printer Configuration Backup dialog window.  This is where the location of the cab file to be created will be entered.
To backup from the command line, use the /b < Full Path & CAB file > option, and optionally specify the target machine name as the last parameter on the command line in the form \\server.

To backup from the application’s user interface:
1.
In the Actions menu select Backup
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Figure 3 - Printer Configuration Backup Dialog
2.
Manually enter the path and filename of the cab file to be created, or browse to the desired directory and enter the file name.

3.
Select Save and then OK to begin the backup.

As the Backup command runs, a progress report is displayed in the lower pane of the Print Migrator 3.0 window. The contents of this report are saved in the pm.log file located in %systemroot%\system32\spool\pm.

Once completed, the cab file contains the related printer registry data and driver files.
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  Note:  If no server name is specified in the Target Server text box, then the operation will be performed on the local system where Print Migrator is being run.
Restore

When restoring a printer configuration to another server using Print Migrator 3.0, the default behavior is to merge the configuration from the cab file to the existing configuration on the target machine.  Note that this is different from Print Migrator 1.0 – which does an Overwrite of the existing configuration on the target with the configuration from the cab file.  In order to do an Overwrite using Print Migrator 3.0, use the /o command line switch or select the Replace (overwrite) existing print shares option in the Restore dialog.

To restore from the command line, use the /r <CAB file> option, and optionally specify the target machine name as the last parameter on the command line in the form \\server.

To restore from the GUI interface:
1.
In the Actions menu select Restore
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Figure 4 - Printer Configuration Restore Dialog
Browse to the directory where the existing cab file is located.

In the File name edit box, enter the name of the cab file to be read.

Optionally specify the machine name in the form \\server in the Target server field.
Select all options of interest (Suppress warning popups, Replace (overwrite) existing printer shares, Attempt LPR to SPM Conversion, and Restore file shares).
Hit the Enter key on the keyboard or select the Open button on the Printer Configuration Restore dialog to begin the restore.
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  Note:  If no server name is specified in the Target Server text box, then the operation will be performed on the local system where Print Migrator is being run.
Print Migrator 3.0 temporarily stops the Spooler service on the target computer in order to restore print queue information.
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  Note: This will also cause the Print Services for Macintosh and the TCP/IP Print Services to be stopped as well, during the restore.
Before running the Restore command on a print server, make sure that the following requirements are met:

· The backup computer and the target computer must be running an x86-compatible CPU.

· Print monitor information is consistent with the backup computer. If a monitor is missing, Print Migrator displays a warning, and you must install the monitor or service and run the Restore again.

· The current user must have administrative rights on the target computer.

· If the source is an NT 4.0 machine, fixprnsv.exe must be run in order to upgrade known-bad kernel mode printer drivers.
Note:  More information about using fixprnsv.exe can be found in the Microsoft Knowledge Base article: Q247196 Overview of Fixprnsv.exe
As the Restore command runs, a progress report is displayed in the lower pane of the Print Migrator window. This output is also saved to the log file named pm.log located in %systemroot%\system32\spool\pm.
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  Note: Print Migrator 3.0 is backwards compatible with cab files created by Print Migrator 2.0 and 1.0.  Cab files created with v3.0, however, cannot be read by the earlier versions.  Cab files created from a cluster print server backup must be created and read by v3.0, as earlier versions did not provide true cluster support.
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  Note: Due to improvements that were made during the testing of Print Migrator 3.0 through the limited beta release, the cab file format for cluster print server backups changed.  This means that cab files created with a beta release of v3.0 will not work with the final released product.  Therefore, it is recommended that new backups are made of these clustered print servers using the final release version of Print Migrator 3.0.
Performing Backups or Restores on a Clustered Print Server
In order to View, Backup from, or Restore to a cluster, the cluster name must be specified in the form of \\cluster.  Running Print Migrator 3.0 on a node of the cluster and specifying no command line arguments will result in the printer configuration from that node being displayed, rather than the cluster’s virtual server.  For the particular cluster that Print Migrator is working with, the print spooler resource must have previously been created.  Print Migrator will log an error message if it doesn’t find a spooler resource on the specified cluster.
In order to backup from or restore to a cluster remotely, the session that is running Print Migrator must have administrators privilege on the cluster.  Using net use or the Print Migrator credential prompt will not gain the proper access to the cluster API’s on the remote cluster.  This is because the API’s use WMI and not named pipes.

Creating a print spooler resource on a cluster is relatively straightforward: from Cluster Admin right click on Resources, select Print Spooler as the type, specify a group, then a disk resource, then a name resource.
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  For more information about installing a Cluster Spooler Resource, see the Microsoft Knowledge Base article: Q197046 How to Set up a Print Spooler on Microsoft Cluster Server
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  Note:  A cluster machine can only be backed up from or restored to by a single instance of Print Migrator 3.0.  Subsequent instances of the Print Migrator application will fail with an error that the temp file could not be created.
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  Note: It may be necessary to stop and start the Spooler service when restoring printer configuration to a Windows NT 4.0 system.  If the Windows NT 4.0 system is a Clustered print server, it will be necessary to take the spooler resource offline, then stop and start the spooler, and lastly bring the spooler resource online again.
Special Considerations

It is important to be aware of the differences in the print subsystem across multiple versions of the Windows Server products, as well as the different configurations that may be in use.  The following sections discuss special configurations that should be given consideration when planning and deploying print servers using Print Migrator 3.0.
Color Printer Profiles
Print Migrator 3.0 does not migrate color profiles.
Printer Forms

Print Migrator 3.0 does not backup or restore custom forms that may be in use.  These should be recreated on the target server after the printer migration is completed.

Simultaneous Connections

Print servers should only be backed up or restored by a single instance of Print Migrator 3.0.  Because Print Migrator will stop and start print-related services, simultaneous operations could experience corruption or failure.
Using Print Migrator 3.0 Remotely

Print Migrator 3.0 supports remote operation for backing up and restoring printer configurations from Windows 2000 Server only.
Restoration Considerations

Driver Types

Native Windows 2000 print drivers may not be restored to NT 4.0 systems. Windows NT 4.0 print drivers run in the Kernel Mode space of the operating system, whereas Windows 2000 systems run native print drivers in User Mode.  To increase backwards compatibility and better interoperability in mixed environment (Windows NT 4.0 and Windows 2000 and later) Windows 2000 can run Kernel Mode drivers as well.  The end result is that it may be beneficial to continue using the Kernel Mode drivers until the clients and the servers all support User Mode print drivers.  (Windows 2000, Windows XP, Windows .NET Server Family)
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  Note: User Mode drivers designed for Windows 2000, Windows XP and Windows .NET Server are referred to as Version 3 drivers.  By contrast, the Kernel Mode drivers that are designed for Windows NT 4 are Version 2 drivers.
Driver Signing

Print Migrator 3.0 will restore printer drivers to a target server irrespective of the driver signing settings level on the target server.
Merging Duplicate Printer Data
When doing a Restore in Merge mode, duplicate printer information may collide.

Port Name Collision – Printer port enumeration is done by the print spooler process.  Print ports are loaded alphabetically, based on the name of the port monitor.  It is possible that two or more ports can be using different port monitors, but have the same port name.  In this case, the first port that is initialized will function correctly and subsequent ports with the same name will fail to initialize.  For example, if a port using standard TCP/IP port monitor and a port using the LPR port monitor are both named the same, the LPR port would function correctly and the standard TCP/IP port would not.  This is because lprmon.dll (LPR port monitor) will be loaded before tcpmon.dll (standard TCP/IP port monitor)
Printer Name Collision – the last printer written to the server with the same name as preexisting printers will be preserved.  (Last write wins model)

Printer Share Name Collision – If printers are restored to a server and there is an existing printer with the same printer share name, then neither of these printers will be shared.  In order to resolve this, select a unique share name for each printer.

Windows NT 4.0 Operations
Windows NT 4.0 with Service Pack 6a is required for Print Migrator 3.0 to perform backup and restore operations.
It may be necessary to stop and start the spooler service when restoring printer configuration to a Windows NT 4.0 system.  If the Windows NT 4.0 system is a clustered print server, it will be necessary to take the spooler resource offline, then stop and start the spooler, and lastly bring the spooler resource online again.
References
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